
The Following Manual gives the basic setup procedure together with the 
calibration and data download instructions
SETTING UP

The  MINCARB  thermal  analysis  and  temperature  instrument  should  be  securely  
mounted  via  the  four  fittings  on  the  cabinet . The  unit  should  be  set  to  the  required  supply  
voltage  via  the  internal  link  and  connected  to  a  fused  power  supply . The  lance  input  should  be  
connected  via  the  round  reyrolle  plug/socket  (+ve  to  L  and  –ve   to   N  ) and  the  cup  input  
connected  to  the  2  pin  compensated  socket  observing  the  cable  colour  code  for  polarity. A  
standard  text  ASCII  printer  can  be  connected  to  the  25 pin  “D”  type  socket. The  instrument  has  
been calibrated and pre-set  to  standard  default  settings which will accommodate the majority of 
applications. However  the  unit  has  been  designed to be custom configured to optimise operation, and  
can be set to correlate with chemical analysis, calculate required additions, and record heat/part number. 
Adjustment  and  interrogation  of  the  settings  can  be  carried  out  via  the  integral  keypad  and LCD 
screen on  the  front  panel. 
 
OPERATION
Bath Temperature

To  take  a  bath  temperature measurement , simply   connect  a   thermocouple  to  
the  dip  lance  and  the  “green”  lamp  above  the  temperature  display  will  light. Immerse  the  unit  into  
the  metal  and  observe  the  display  , the  amber  lamp  will  light and  the  actual   temperature  will  be  
indicated  on  the  temperature  display . As the Mincarb  determines  an  acceptable  plateau  the  red  
lamp  will  light  and  the  display  will  show  the  plateau  temperature (this  would  be  immediately  
printed  out  with  date  and  time  should  the  option  be  selected). The  temperature  would  be  held  on  
the  display  until  the  next  measurement  is  taken (the  green  lamp  indicating  that   the  thermocouple  
is  serviceable).   
 
Thermal  Analysis  TA (Carbon Cup)

To  make  a  measurement  of   CE, C , and Si  simply  connect  a  “carbon cup”  to  
the  stand , the  green  lamp  above  the  C  display  will  light . Pouring  metal  into  the  cup will  cause  
the  green  lamp  to  flash  indicating  measurement  in  progress , and  the  LCD  display  will  begin  to  
show  the  actual  cooling  curve (the  real  time  temperature  is  displayed  in  the  right  hand  corner  of  
this  screen ). As  the  Mincarb  analyses  the  curve  and  mathematically  determines  the  optimum  arrest  
point  for  the  liquidus , the  CE  value  will  be  shown  in  the  large  L.E.D.  display  . The  system  will  
continue  to  monitor  the  cooling  rate  and  determine  the  solidus/eutectic   using  the same exacting  
methods .When  satisfied  the  C  and  Si  are  displayed  on  the  L.E.D.s  and  the  arrest  points  market  
on  the  curve  to  offer  the  operator  an  opportunity   to  verify  the  result. The  red  lamp  is  then  lit  to  
indicate  end  of  measurement (the  result  , date  and  time  would  be  sent  to  the  printer  should  this  
option  be  selected). The  displays  would  show  the  result  of  this  cup  until  a  further  cup  was  
poured. 
 
FUNCTIONS  AND  CONFIGURATION

A number  of  standard  and  advanced  features  are  available  on  the  Mincarb  which  are  
accessible  via  the  membrane   keyboard. The  functions  are  displayed  on  the  screen  as  a  reminder  
and  prompts  are  given  to  assist  operation. 
 
Function 1 (F1)
Heat / Part No input

The  operator  can  enter  a  “Heat”  or  “Part”  number  related  to  the  cast  simply  by  
pressing  the  F1 Key  prior  to  pouring  the  cup . The  Heat  I.D. screen  appears and  invites  you  to 
enter  up  to  8  characters (Using  the   Alpha  key  to  select  between  letters  and  numbers). This  I.D.  is  
then  entered  onto  the  display  and  printout . 
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Function 2 (F2) 
Configuring the Mincarb

A menu  function  is  accessed  via  the  F2 Key , this  allows  a  large  menu  with  
several  sub-menus  to   be  selected. The  first  menu  offers  the  following  options . 
 

MENU FUNCTION SUB-
MENU

OPERATION 
1 TA:   Sends a report to the printer of the cup results for the selected  date 

( holds  up to 1000 measurements) 
2 Temperature Lance:  As above but for temperature lance 
3 (Reserved for future developments) 

1. Print  Report 

4 Change date of print out  
1 TA:    Displays past results on the LCD screen with date and time for quick   

reference 
2. Recall 

measurement 
2 Temperature:    as above for Lance 
1 Cup:  Allows  a  set  temperature  to   be  injected  from  an external  

calibrated  source  to  automatically  adjust any  offset  errors , this  should   
be  carried  out  by  an  engineer  experienced  in  the calibration  of  
thermal  analysis  instruments.(see below) 

3. Calibrate  Cup 

2 Lance:   as above for lance input 
4. Diagnosis Engineers mode for analysis of input signal 
5. Configuration This  setting  has  a  number  of  sub-menus  to  allow  for  a  wide  range  of  user  

selectable  options  and  is  protected  by  password. 
The  default  password  is  1597.   

Configuration Sub-Menus 
 

Operation 
1 Parameter:  Graph scale , duration , no of readings, Liq detection, 

Eut detection, Min rec, Silicon calculation type ½, Display RM/BH, 
Name of Metal Type (Use Alpha key for letters)   

2 Chemistry  Correction:  CE, C, Si , P offsets (changed to match 
known offsets) 

3 Equation:  CE , C, Si, P equation (changed in correlation with 
laboratory analysis) 

4 Ranges:  CE Min-Max , C Min-Max , Si Min-Max (used to calculate 
additions) 

5 Additions:  C and FeSi Valance (% C / Si in trimming material) and 
C and FeSi Recovery (% trimming material recovered in melt from 
experience) 

6-
8

Reserved for future developments 

1-8 
Metal Types   

9 Restore Factory settings: (for this metal type) 

1. Thermal 
Analysis 

9 TA General:  Applies to  all   metal  types  for  Calibration temperature, 
correction, Display SC (saturated carbon) and  engineers  diagnostics  
mode . 

2 Lance Parameters Calibration temperature, Correction, Min temp, Plateau Tol +/- C, 
Readings within Tol, Lance fail after (sec.), T/C Type R, S, B. 

3 Oxygen Parameters If option installed. 
4 Printer Auto printing after TA measurement 0=off  /  1= on 

Auto printing after Lance measurement 0=off  /  1= on 
5 Communication If option installed 
6 Change password Replace factory set password with selection of 4 numbers. 
7. Time / Date Set  current date separated by .  

Set  current  time  separated  by  : 

NOTE: All  Changes to parameter are accepted by pressing “Enter” and menu is exited by        
 pressing “ESC” . 
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Function 3 (F3)
Metal type

Pressing F3 when in the operate mode will select the next metal type. Each press will increment the 
metal type by one, the Metal type name is shown at the top of the screen and the corresponding 
configuration will be set automatically to all parameters. (alternatively, pressing the number of the metal 
type on the numeric keyboard will select a particular metal type)  
 
Function 4 (F4)
Additions

If the ranges and additions data input has been completed (see Function 2.) the Mincarb will 
automatically indicate if the Metal is outside specification for the metal type selected. This will be indicated 
by a “^” (over range) or “v” (under range) beside the result shown on the LCD screen. To calculate the 
additions required to bring the metal into range simply press the F4 key, the Mincarb will request an input of 
the metal weight and display the ranges set in the configuration. Input the metal weight and press enter, 
the required additions will be calculated based and displayed in the same unit as the metal weight input. 
Pressing esc. will return the instrument to operate mode.  
 
Special Recovery Mode
Should the user password be lost, a master password of  0815 can be used to access the configuration 
menu allowing a new user password to be input. 
 
The Measurement data  stored in the Mincarb can be erased by pressing “shift” &” F3” whilst in 
Configuration menu ( a request is made to re-enter the password before erase complete ). 
 
The complete configuration can be reset to factory settings and measured data erased by pressing “shift” & 
“ F4” whilst in  configuration menu ( a request is made to re-enter the password before erase complete). 
 
Varification and Calibration
The Mincarb incorporates high quality Analogue – Digital converters with software temperature 
conversion and calibration. Temperature measurement is very stable and drift is unlikely. Avoid 
adjusting the instruments calibration unless a genuine reason exists. 
Calibration should only be carried out by an engineer experienced in the operation of 
temperature measurement and thermal analysis instrumentation, as any small offset could 
have dramatic implications in the calculation of results. 
 
Verification of Thermal Analysis (TA) instrument accuracy
Connect a “Mincal” cup simulator or calibrated thermocouple source with automatic cold junction 
compensation directly to the cup stand and allow the system to equalise in temperature for at least 10 
minutes. (The Mincarb Thermal analysis input is set as a type “K” thermocouple) Inject an ambient 
temperature and ensure the Mincarb resets and shows a steady green cup light. Inject a simulated 
measurement and observe the small digital units in the top right hand corner of the LCD screen. The display 
incorporates a delay but will level out at a steady reading which should agree with the injected signal. 
Record the reading and inject the next setting, repeating for a reasonable range ( if using a Mincal simply 
inject first Low then High input ). If the reading is erratic or a significant error exists this may be due to 
faulty wiring, incorrect compensating cable or poor cup connector. If all is in order and the instrument is 
believed to require calibration , follow the procedure below. 
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Verification of temperature lance instrument accuracy 
Connect a “Mincal” lance simulator or calibrated thermocouple source with automatic cold junction 
compensation directly to the lance tip, and allow the system to equalise in temperature for at least 10 
minutes. (The Mincarb Lance input can be set to either R, S, or B type thermocouples ensure the test 
instrument is compatible) Inject an ambient temperature and ensure the Mincarb resets and shows a steady 
green lance light. Inject a simulated measurement and observe the Large LED temperature display. The 
reading should agree with the injected signal and the red lamp light to indicate that a plateau is detected. 
(NOTE: Some simulator instrument overshoot the required output for a few seconds which the Mincarb can 
detect as a plateau, if this is suspected simply short out the output of the source whilst set to the required 
setting to give a green light, and remove the short to display the reading.) Repeat the procedure for the 
intended range. 
 
Calibration Procedure Thermal Analysis TA input
Select calibration mode for the TA input ( F2 – 3 – 1 ) connect a calibrated mV source designed for 
calibration of thermocouple instrumentation to the cup stand using “K” type compensating or extension 
leads. [NOTE: it is important to test from the cup stand as this is testing the full instrumentation system.]  
Allow 10 minutes for the connection point temperature to stabilise. Note the desired calibration 
temperature on the Mincarb screen and input the corresponding signal. (either converted to degrees C with 
automatic cold junction compensation, or as a true mV with a manual offset  for cold junction depending on 
test instrument used). The actual reading will be displayed on the LCD screen to one decimal place and after 
a stable temperature is reached the measurement will be stored and an offset calculated. You will then be 
prompted to accept or reject this new offset (the old offset is left on the screen for reference). If accepted 
the new offset is stored , if rejected the Mincarb returns to the old offset. 
 
Calibration Procedure Temperature (lance) input
As for “cup” calibration but using the correct compensating cable and connector system for the type of 
Thermocouple in use. (if the reading is unstable or a large discrepancy seen, it may be a possibility that the 
insulation within the lance is failing and a full lance rewire should be carried out). 
 

NOTE: All  Changes  to  parameter  are  accepted  by  “Enter”  and exited  by  “ESC” 
 
DATA DOWNLOAD
If the Mincarb is operating on software version 20a or higher, it is capable of downloading the Data from the 
in-built memory to a PC via a serial link. This can be used as a Database or for direct correlation between 
Laboratory and Thermal analysis. ( If the Mincarb is running on an older software version, it will be possible 
to upgrade , contact Minco for assistance.) 
 
Installing “MINCARB REPORT” Data Download software onto PC
Minco can supply a “Mincarb Report” program which can be installed onto a PC / Laptop running under 
Windows 95 or higher. To install, insert the CD into the drive and select “RUN” from Start Menu. Click 
“Browse” and select the setup.exe program from the install folder in the CD Drive (i.e. D: / E: etc.) . Click 
open and the install shield will run. Follow the on screen commands to complete installation. After 
installation a “Mincarb Report” short cut icon appears in a window, Copy the shortcut to the desktop if 
required and close window. Important Note: Before running the program ensure the correct dBase level is 
set in the PC. Proceed as follows. From the start menu, select “settings” – “control panel”. Double click on 
the BDE Administrator. When in the administrator click + on drivers, + on native and click Dbase icon. The 
level on the software should be set to Level 5. If not, click in the box and use pull down arrow to set to 5. 
Close the window using the X button and ensure to save the change on exit. Close control panel . 
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Running “MINCARB REPORT” Data Download Softare
Using a serial download lead, connect the Mincarb serial output ( 25 pin D type male plug) to the serial input 
COM 1 of the PC / Laptop. Click “Mincarb Report” Icon on desktop or from start menu select Programs / 
Mincarb / Mincarb Report. When the Program window is running pull down the File Menu and select “new” 
to create a new database or “open” to add data to an existing data base. NOTE: As the program 
operates on dBase files the names must have a maximum of 8 characters with no spaces. Select 
the file name and click Open. To Download Data simply select Download from the File menu or Click the 
Download button on the top toolbar. All of the results held in memory on the Mincarb will be input into the 
correct column in the data base with the Temperature and Thermal Analysis results appearing together in 
Date Time order. The Thermal analysis will be allocated measurement type 0 and Temperature readings 
type 1, with the measured temperature appearing in column 21 which may be off screen depending on the 
resolution of the monitor. NOTE: (should an error message appear during download stating “device already 
open” it is possible that com port 1 is already used by another program or device, this should be exited 
before retrying).  
 

Sorting / Correlate the Data
Sorting 

To sort the Data, Click the Select button on the top toolbar. A window will appear to allow the data 
to be sorted by Date (range), Measurement Type, Metal Type or Filter (Note: The date defaults to the date 
of the download, ensure the date or date range of the required measurements are selected to the display 
relevant data). Multiple selections can be made to allow specific sorting, i.e. Results from 11th to 15th

November for Thermal Analysis of metal types 2 & 6 with Carbon between 3.4% and 3.6%. Once the filters 
have been set click OK to sort Data. 
Data can be further edited via the edit button and deleted using the – button. Once sorted the report can be 
previewed on screen or printed using the toolbar buttons.  
If more advanced data handling or SPC is required, close the Mincarb Report program (the raw Data is saved 
automatically) and import the file into any program capable of reading *.dbf files (i.e. Spreadsheet or SPC 
programs). 
 
Correlate

This facility can be used to correlate the Mincarb results with the Laboratory, however this feature 
should be carried out with caution as altering the equation used can greatly effect overall results.  

To correlate the data, input the Lab Carbon and Silicon into the column provided (both must be 
entered) using the Select tab, tick the bottom box “show only data with lab entries” (ensure correct date 
range is set) and click “OK”. Pull down the Calculate menu and click “regression C & Si” new figures will be 
shown and applying the new equation . It is then possible to graph the result and show the new equation to 
be entered into the Mincarb for improved agreement between lab and thermal analysis. This must be done 
manually and silicon 2 must be selected in the parameters for the metal type in the configuration menu. 
 

TECHNICAL  ASSISTANCE
Minco  can  offer  a  full  support  package including training, calibration  and  assistance  in  configuring  

the  Mincarb  to  give  results  that  consistently  correlate  with  laboratory  analysis. If assistance is 
required please contact your Minco representative. 
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